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Legal Notices

Novell, Inc. makes no representations or warranties with respect to the contents or use of this documentation, and 
specifically disclaims any express or implied warranties of merchantability or fitness for any particular purpose. 
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on the current U.S. export exclusion lists or to any embargoed or terrorist countries as specified in the U.S. export 
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Copyright © 2005-2006 Novell, Inc. All rights reserved. No part of this publication may be reproduced, photocopied, 
stored on a retrieval system, or transmitted without the express written consent of the publisher.

Novell, Inc. has intellectual property rights relating to technology embodied in the product that is described in this 
document. In particular, and without limitation, these intellectual property rights may include one or more of the U.S. 
patents listed at http://www.novell.com/company/legal/patents/ and one or more additional patents or pending patent 
applications in the U.S. and in other countries.

Novell, Inc.
404 Wyman Street, Suite 500
Waltham, MA 02451
U.S.A.
www.novell.com
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Novell Trademarks

For Novell trademarks, see the Novell Trademark and Service Mark list (http://www.novell.com/company/legal/
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Third-Party Materials

All third-party trademarks are the property of their respective owners.
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About This Guide

This Novell® GroupWise® 7 Migration Utility for Microsoft Exchange Installation and Migration 
Guide explains how to install, configure, and run the GroupWise Migration Utility for Microsoft 
Exchange. The guide is divided into the following sections: 

Chapter 1, “Installing the GroupWise 7 Migration Utility for Microsoft Exchange,” on page 9
Chapter 2, “Migrating Your Exchange System to GroupWise 7,” on page 27
Chapter 3, “Using the GroupWise 7 Import Utility for Microsoft Outlook,” on page 53
Appendix A, “Novell eDirectory Attributes Populated from Exchange,” on page 59
Appendix B, “Linux Migration,” on page 61
Appendix C, “GroupWise 7 Migration Utility Error Messages,” on page 63
Appendix D, “Documentation Updates,” on page 67

Audience

This guide is intended for network administrators who want to move from Microsoft Exchange to 
GroupWise. 

Feedback

We want to hear your comments and suggestions about this manual and the other documentation 
included with this product. Please use the User Comment feature at the bottom of each page of the 
online documentation, or go to www.novell.com/documentation/feedback.html and enter your 
comments there.

Documentation Updates

For the most recent version of the GroupWise 7 Migration Utility for Microsoft Exchange 
Installation and Migration Guide, visit the GroupWise Gateways Documentation Web site (http://
www.novell.com/documentation/gwgateways).

Additional Documentation

For information about the GroupWise Gateway for Microsoft Exchange, see the GroupWise 
Gateways Documentation Web site (http://www.novell.com/documentation/gwgateways).

For additional GroupWise documentation, see the following guides at the GroupWise 7 
Documentation Web site (http://www.novell.com/documentation/gw7):

• Installation Guide
• Administration Guide
• Multi-System Administration Guide 
• Interoperability Guide
• Troubleshooting Guides
• GroupWise Client User Guides
• GroupWise Client Frequently Asked Questions (FAQ)
7

http://www.novell.com/documentation/gwgateways
http://www.novell.com/documentation/gwgateways
http://www.novell.com/documentation/gwgateways
http://www.novell.com/documentation/gw7
http://www.novell.com/documentation/gw7
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Documentation Conventions

In Novell documentation, a greater-than symbol (>) is used to separate actions within a step and 
items in a cross-reference path.

A trademark symbol (®, TM, etc.) denotes a Novell trademark. An asterisk (*) denotes a third-party 
trademark.

When a single pathname can be written with a backslash for some platforms or a forward slash for 
other platforms, the pathname is presented with a backslash. Users of platforms that require a 
forward slash, such as Linux*, should use forward slashes as required by your software.

When a startup switch can be written with a forward slash for some platforms or a double hyphen for 
other platforms, the startup switch is presented with a forward slash. Users of platforms that require 
a double hyphen, such as Linux, should use double hyphens as required by your software.
7 Migration Utility for Microsoft Exchange Installation and Migration Guide
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1Installing the GroupWise 7 
Migration Utility for Microsoft 
Exchange

Your migration from Microsoft Exchange to Novell® GroupWise® 7 can go more smoothly if you 
invest time in planning. The tasks below help you meet system requirements, plan your migration 
from start to finish, and install the Migration Utility on one or more workstations:

• Section 1.1, “Meeting Migration Utility System Requirements,” on page 9
• Section 1.2, “Planning Your Migration from Exchange to GroupWise,” on page 10
• Section 1.3, “Installing the Migration Utility,” on page 20
• Section 1.4, “Exchange Migration Planning Worksheet,” on page 21
• Section 1.5, “Exchange to GroupWise User List,” on page 23
• Section 1.6, “Exchange Migration Quick Checklist,” on page 24

1.1  Meeting Migration Utility System 
Requirements

Exchange system requirements:
• Microsoft Exchange 5.5 or later system
• Outlook* 2002 client with Service Pack 1 or later installed on users’ workstations

GroupWise system requirements:
• GroupWise 7 or later system on one of the following operating systems:

• Novell Open Enterprise Server (NetWare® or Linux version) with the latest Support 
Pack

• NetWare 5.1 or 6.x with the latest Support Pack
• SUSE® Linux Enterprise Server 9 with the latest Support Pack
• Windows* 2000 Server or Windows 2003 Server with the latest Service Pack 

• GroupWise 7 or later Windows client installed on users’ workstations
• For complete GroupWise system requirements, see “GroupWise System Requirements” in 

the GroupWise 7 Installation Guide
Migration Utility workstation requirements:

• Windows XP or later with the latest Service Pack installed and no anti-virus software 
running during the migration

• Outlook XP/2002 client with Service Pack 3 or later
• Collaboration Data Objects Component installed with Outlook
• GroupWise 7 or later Windows client

or
Installing the GroupWise 7 Migration Utility for Microsoft Exchange 9
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GroupWise Connector for Microsoft Outlook
• Novell ClientTM 4.90 with Support Pack 2 or later

1.2  Planning Your Migration from Exchange to 
GroupWise
Several aspects of your system must be considered as you plan your migration from Exchange to 
GroupWise:

• Section 1.2.1, “Determining Migration Scope,” on page 10
• Section 1.2.2, “Gathering Information about Your Exchange System,” on page 11
• Section 1.2.3, “Planning Your GroupWise System,” on page 12
• Section 1.2.4, “Preparing eDirectory for Your GroupWise System,” on page 14
• Section 1.2.5, “Determining Migration Results,” on page 16
• Section 1.2.6, “Migration Scenarios,” on page 16
• Section 1.2.7, “Estimating Time Requirements,” on page 19

Print the Exchange Migration Planning Worksheet and the Exchange to GroupWise User List to help 
you gather the information you need as you perform the migration. Use the Exchange Migration 
Quick Checklist to track migration progress.

1.2.1  Determining Migration Scope
• “Migration Process” on page 10
• “Migration Utility Usage” on page 11

Migration Process

If you are migrating a small to moderate Exchange system, you can complete the migration in a 
single-stage process, perhaps over a weekend. However, if you are migrating a large Exchange 
system, especially one with multiple remote sites, you cannot complete the migration in a single day 
or even a weekend. Instead, you must migrate parts of the system over a period of time in a multi-
stage process.

If you need a multi-stage migration, you need to implement the GroupWise Gateway for Microsoft 
Exchange to keep messages flowing between the two e-mail systems throughout the migration 
process. The Exchange Gateway is available on the Novell Downloads page (http://
download.novell.com/pages/PublicSearch.jsp). Documentation for the Exchange Gateway is 
available on the GroupWise Gateways Web site (http://www.novell.com/documentation/
gwgateways). 

EXCHANGE MIGRATION WORKSHEET

Under Item 1: Migration Scope, mark whether you need a single-stage process or a multi-stage process 
to complete the migration.
7 Migration Utility for Microsoft Exchange Installation and Migration Guide
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Migration Utility Usage

Again, depending on the size of your Exchange system, you might be able to run the Migration 
Utility on a single workstation, or you might need to run the Migration Utility concurrently on 
multiple workstations. If your Exchange system is small, consisting perhaps of a single Exchange 
server, you can run the Migration Utility on a single workstation. But if your Exchange system is 
large, consisting of dozens of Exchange servers, running the Migration Utility on multiple 
workstations gets the job done much more quickly. You should plan to use the fastest workstations 
available in your environment. If possible, plan to locate the workstations close to the Exchange 
server being migrated and use the fastest network connection available.

1.2.2  Gathering Information about Your Exchange System
• “Exchange Version” on page 11
• “Exchange System Information” on page 11
• “Exchange Administrator Information” on page 12

Exchange Version

The Exchange Migration Utility can migrate from Exchange 5.5, 2000, and 2003. The setup steps 
are different if you are using Exchange 5.5.

Exchange System Information

You migrate users from one Exchange server at a time. You can list all of your Exchange servers on 
the Exchange to GroupWise User List. When you do your GroupWise planning, you add post offices 
to the list. To help with the GroupWise planning, you should know the number of mailboxes on each 
Exchange server and the size of the Exchange data on each Exchange server. This information helps 
you determine how many post offices you need. In order for the Migration Utility to access each 
Exchange server, you need to know the name of one mailbox on each server. You also need to know 
which Exchange server is the public folder server or if folders are scattered across multiple 
Exchange servers.

EXCHANGE MIGRATION WORKSHEET

Under Item 2: Migration Utility Usage, mark whether you need one Migration Utility workstation or 
multiple workstations to complete the migration.

EXCHANGE MIGRATION WORKSHEET

Under Item 3: Exchange Version, mark the version of Exchange you are migrating from.

EXCHANGE MIGRATION WORKSHEET

Under Item 4: Exchange System Information, record the required information about your Exchange 
system, using the Exchange to GroupWise User List to build your list of Exchange servers.
Installing the GroupWise 7 Migration Utility for Microsoft Exchange 11
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Exchange Administrator Information

The Exchange Migration Utility needs to run with administrator rights to all Exchange servers. It 
also needs a MAPI profile that you create on each Exchange server. The MAPI profile for each 
server requires a mailbox name on each server. 

1.2.3  Planning Your GroupWise System
• “GroupWise System Information” on page 12
• “Internet Domain Name” on page 13
• “GroupWise Resources for Exchange Public Folders” on page 13
• “Client Software Distribution” on page 14

GroupWise System Information

You migrate users from one Exchange server into one GroupWise post office at a time. The number 
of Exchange users you have determines how many GroupWise post offices you need. Typically, you 
create a new GroupWise system for the migrated Exchange users, but it is possible that some people 
in your organization are already using GroupWise. Then you would add the migrated Exchange 
users to an existing GroupWise system.

NOTE: The instructions in this guide are written for those who are creating a new GroupWise 
system. Those with an existing GroupWise system can easily adapt the instructions to their 
circumstances.

The maximum size for a GroupWise post office can range from 1000 to 2500 users, taking into 
account the following considerations:

• Minimizing the impact if you have a problem with a server.
• Avoiding excessive time requirements for performing post office and mailbox maintenance 

activities including backups.
• Allowing room to grow while maintaining best performance. 

For more information about planning the size and composition of your GroupWise post offices, see 
“Understanding the Purpose of Post Offices” and “Planning a New Post Office ” in “Post Offices” in 
the GroupWise 7 Administration Guide. See also the GroupWise 6.5 Best Practices Guide (http://
www.novell.com/coolsolutions/gwmag/features/a_gw65_best_practices_guide_gw.html). 
GroupWise 6.5 best practices can be applied to GroupWise 7.

Use the Exchange to GroupWise User List to list the GroupWise post offices where you want to 
migrate Exchange users. Typically, one Exchange server migrates to one GroupWise post office, but 
you might need to migrate multiple Exchange servers into one GroupWise post office or to migrate 
one Exchange server into multiple post offices. Ideally, each post office should have a unique name.

EXCHANGE MIGRATION WORKSHEET

Under Item 5: Exchange Administrator Information, record a username that the Migration Utility can run 
as and a MAPI profile that it can use to access mailboxes.
7 Migration Utility for Microsoft Exchange Installation and Migration Guide
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IMPORTANT: Your list should reflect the relationships between all Exchange servers and 
GroupWise post offices.

In GroupWise, post offices are organized within domains. For information about planning the 
domains for the new post offices, see “Understanding the Purpose of Domains” and “Planning a 
New Domain” in “Domains” in the GroupWise 7 Administration Guide.  Ideally, each domain 
should have a unique name.

When you run the Migration utility, you need to map a drive to the domain where each post office is 
located. Make sure you know a username and password with sufficient rights to map a drive to each 
domain.

Typically, one domain or post office is placed on a server. Plan your hardware requirements for your 
GroupWise system accordingly. Consider the directory structure you want to use for post office 
directories and domain directories.

Internet Domain Name

Your GroupWise system needs an Internet domain name in order to be accessible from the Internet. 
If you want users to be able to reply to and forward messages after they have been migrated from 
Exchange to the GroupWise system, you must use the same Internet domain name for the 
GroupWise system as you use for your Exchange system. You can use more than one Internet 
domain name.

GroupWise Resources for Exchange Public Folders

Exchange public folders become GroupWise shared folders. Your Exchange system might have one 
public folder server, or public folders might be scattered across several Exchange servers. If you 
have one public folder server, all public folders are migrated into the same post office. If you have 
public folders on multiple Exchange servers, you can choose to migrate them all into one post office 
or you can choose to migrate them into different post offices, depending on which users access 
which public folders most frequently.

The most convenient way to handle ownership of the shared folders is for GroupWise resources to 
own them. (In GroupWise, a resource is an item or place, such as a computer, company vehicle, or 
conference room, that users can schedule or check out.) However, a specific GroupWise user must 
still own each resource. You might find it convenient to own each resource yourself or you can 
choose a different owner.

The owner of each public folders resource controls which users the folders are shared with and what 
rights each user has to the folders. Initially, the rights match the original public folders because the 
Migration Utility applies the Access Control List (ACL) share rights to the GroupWise users that 

EXCHANGE MIGRATION WORKSHEET

Under Item 6: GroupWise System Information, list the post offices, domains, servers, and directories 
needed for your GroupWise system, using the Exchange to GroupWise User List to associate post 
offices with Exchange servers.  Also list the username and password that can be used to access them.

EXCHANGE MIGRATION WORKSHEET

Under Item 7: Internet Domain Name, specify the Internet domain name for your GroupWise system..  
Installing the GroupWise 7 Migration Utility for Microsoft Exchange 13



14 GroupWise 

novdocx (E
N

U
)  01 February 2006
originally had rights to the public folders in the Exchange system. However, GroupWise does not 
include the concept of granting rights to all users. In GroupWise, rights are granted on a user-by-user 
basis.

Client Software Distribution

You can distribute the GroupWise Windows client to users on a CD or you can automate the process 
using GroupWise AutoUpdate, GroupWise SetupIP, or ZENworks® Desktop Management. For 
information about these distribution alternatives, see “Distributing the GroupWise Client” in 
“Client” in the GroupWise 7 Administration Guide. 

IMPORTANT: Make sure all client workstations meet the requirements listed in “GroupWise 
Client Requirements” in the GroupWise 7 Installation Guide.

The Windows client is required in order for users to use the GroupWise Import Utility for Microsoft 
Outlook to import their PST files into their GroupWise mailboxes. After this task has been 
accomplished, they can use the WebAccess Client, the Cross-Platform client, a POP or IMAP e-mail 
client, etc., to access their GroupWise mailbox. They can even continue to use Outlook, along with 
the GroupWise Connector for Microsoft Outlook, if they want.

1.2.4  Preparing eDirectory for Your GroupWise System
• “eDirectory Tree Name” on page 14
• “Post Office and Domain Contexts” on page 15
• “User and Distribution List Contexts” on page 15
• “User Object Creation” on page 15

eDirectory Tree Name

GroupWise stores its configuration information in eDirectoryTM objects. Therefore, you must prepare 
your eDirectory tree to accommodate your planned GroupWise system. Make sure you have a 
username and password with sufficient rights to create objects.

EXCHANGE MIGRATION WORKSHEET

Under Item 8: Resources for Public Folders, specify the names of one or more GroupWise resources that 
you want to own the shared folders that were Exchange public folders.  

EXCHANGE MIGRATION WORKSHEET

Under Item 9: Client Software Distribution, mark how you want to distribute the GroupWise Windows 
client to users.  

EXCHANGE MIGRATION WORKSHEET

Under Item 10: eDirectory Tree Name,  specify the name of the eDirectory tree where you want to create 
the post offices for the migrated Exchange users. Also specify a username and password that can be 
used to access the tree.
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Post Office and Domain Contexts

There are many ways to organize the container objects where Post Office objects and Domain 
objects are placed. For some examples, see “Domain Context” in “Installing a Basic GroupWise 
System” in the GroupWise 7 Installation Guide.

User and Distribution List Contexts

User objects and Distribution List objects are typically created in different containers from where 
Post Office objects and Domain objects are created. User objects and Distribution List objects are 
created in GroupWise with the same names they had in Exchange.

Although it is possible to create multiple eDirectory objects with the same name, as long as they are 
in different contexts, you should plan for all GroupWise User objects and Distribution List objects to 
have unique names because ongoing administration is simplified. This might require renaming some 
Exchange user accounts and distribution lists before the migration.

If you are going to migrate users and distribution lists from one Exchange Server into multiple 
contexts in eDirectory, use the Exchange to GroupWise User List to list each user and distribution 
list and the context where you want to migrate it. You need this information in order to create an 
eDirectory account file to inform the Migration Utility of the context where you want each user and 
distribution list migrated, as described in Section 2.2.2, “Creating eDirectory Account Files,” on 
page 33.

User Object Creation

The Migration Utility can create both eDirectory User objects and GroupWise accounts at the same 
time, it can add GroupWise accounts to existing User objects, or it can add items to existing 
GroupWise accounts. It can be preferable to create the User objects and GroupWise accounts in 
advance for the following reasons:

• It streamlines the migration process because the Migration Utility has less to do.
• For a single-stage migration, it simplifies the handling of incoming Internet mail because it can 

be routed directly into the new GroupWise system as the migration begins.

EXCHANGE MIGRATION WORKSHEET

Under Item 11: Post Office  and Domain Contexts, list the contexts where you plan to create Post Office 
objects and Domain objects.

EXCHANGE MIGRATION WORKSHEET

Under Item 12: User  and Distribution List Contexts, list the contexts where you plan to create User 
objects and Distribution List objects.

EXCHANGE MIGRATION WORKSHEET

Under Item 13: User Object Creation, mark whether  you want to create User objects and GroupWise 
accounts in advance or have the Migration Utility do it for you.
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1.2.5  Determining Migration Results
• “Migration Options” on page 16
• “Migration Filter” on page 16

Migration Options

You can control certain aspects of how the Exchange data is organized in users’ GroupWise 
mailboxes:

• You can select the name of the folder into which each Outlook mailbox is migrated. The default 
is Exchange.

• You must set a default password that is placed on all GroupWise mailboxes. 

IMPORTANT: Make sure that users set a personal password as soon as possible.

• You can select whether the items in each user’s Outlook Inbox go directly into the GroupWise 
mailbox, rather than into the Exchange folder. 

• You can select whether items from the Outlook Drafts folder go into the GroupWise Work in 
Progress folder, rather than into the Exchange folder.

Migration Filter

You can speed up the migration process by not migrating some types of Exchange data. For 
example, you might not want to migrate:

• Items that are older that a specified date
• Deleted items
• Sent items
• Journal items, because GroupWise does not have a journal feature (However, users might still 

want their journal data as a reference.)

1.2.6  Migration Scenarios
These migration scenarios summarize your migration options.

• “Small System Migration: One Exchange Server to One GroupWise Post Office” on page 17
• “Large System Migration: One Exchange Server to Multiple GroupWise Post Offices” on 

page 17
• “Large System Migration: Multiple Exchange Servers to One GroupWise Post Office” on 

page 18

EXCHANGE MIGRATION WORKSHEET

Under Item 15: Migration Options,  specify the migration options you want to use.

EXCHANGE MIGRATION WORKSHEET

Under Item 16: Migration Filter,  mark the types of items that you want to filter out of the migration.
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• “Large System Migration: Multiple Exchange Servers to Multiple GroupWise Post Offices” on 
page 19

Small System Migration: One Exchange Server to One GroupWise Post Office

If your Exchange system is small, you can perform the migration as a single-stage process. The 
Migration Utility can migrate users from one Exchange server into one GroupWise post office. 

Figure 1-1   Small system migration

The migration process for a small system entails three Migration Utility sessions: one for mailboxes, 
one for distribution lists/groups, and one for public folders. The mailbox session must be completed 
before you start the distribution list/group session. The distribution list/group session must be 
completed before you start the public folder session.

If you have more than one Exchange server or you want to divide your Exchange users into more 
than one GroupWise post office, you must perform a large system migration.

Large System Migration: One Exchange Server to Multiple GroupWise Post Offices

You might want to migrate your Exchange users into multiple GroupWise post offices. You need a 
separate Migration Utility session for the users going into each post office.

Figure 1-2   One Exchange Server to Multiple Post Offices
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After all users have been migrated, then you migrate distribution lists/groups and public folders 
from the Exchange system.

Large System Migration: Multiple Exchange Servers to One GroupWise Post Office

You might need to migrate users from multiple Exchange servers into one post office. You need a 
separate Migration Utility session for the users on each Exchange server.

Figure 1-3   Multiple Exchange Servers to One GroupWise Post Office
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from the Exchange system.
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Large System Migration: Multiple Exchange Servers to Multiple GroupWise Post 
Offices

You might need to migrate users from multiple Exchange servers to multiple GroupWise post 
offices. This can require a substantial number of Migration Utility sessions to cover all the pairings 
of Exchange server and GroupWise post office.

Figure 1-4   Large System Migration

After all users have been migrated, then you migrate distribution lists/groups and public folders 
from the Exchange system.

1.2.7  Estimating Time Requirements
The migration process can require a substantial amount of time. The following factors influence the 
amount of time it takes: 

• How the migration filter options are set, as described in “Migration Filter” on page 16
• Number of mailboxes
• Size of the mailboxes
• Content of the mailboxes (Large numbers of recurring appointments are especially high in 

overhead.)
• Performance of the network connections between the Exchange servers and the Migration 

Utility workstations
• CPU speed and memory on the Migration Utility workstations
• Whether or not you created the User objects and GroupWise accounts in advance
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The larger the amount of e-mail, the more workstations you should concurrently run the Migration 
Utility on, in order to speed up the process. The only accurate way to determine how long the 
migration process will take is to do a trial run on a small number of mailboxes and estimate based on 
the results.

1.3  Installing the Migration Utility
If you are performing a small system migration, install the Migration Utility on one Windows 
workstation. If you are performing a large system migration, install the Migration Utility on multiple 
Windows workstations (worksheet item 2).

IMPORTANT: Do not install and run the Migration Utility on Exchange servers.

1 Make sure that Outlook is already installed.
2 Install the GroupWise Windows client, as described in “Installing the Windows Client” in the 

GroupWise 7 Installation Guide.
Each workstation where you install the Migration Utility must already have Outlook and the 
GroupWise client installed because the Migration Utility relies on MAPI as provided by these 
e-mail clients. The Migration Utility updates the MAPI provider, so it must be installed after 
the clients.
To install the GroupWise Migration Utility:

3 Make sure that you have administrator rights to the Exchange server that you want to migrate 
(worksheet item 5).

4 At a workstation that meets the system requirements listed in Section 1.1, “Meeting Migration 
Utility System Requirements,” on page 9, run setup.exe, then click Next to continue with 
the installation.

5 Click Yes to accept the license agreement.
6 Click Next to accept the default installation location.

or
Browse to and select the directory where you want to install the Migration Utility, click OK, 
then click Next.

7 Select the Program Folder where you want the Setup program to create the program icon for the 
Migration Utility (typically Novell GroupWise), then click Next. 

8 Click Finish when the installation is complete.
9 Repeat Step 4 through Step 8 for each workstation where you want to run the Migration Utility.

As an alternative, you could map a drive from other workstations to a central installation of the 
Migration Utility. However, the Migration Utility runs faster when installed locally.

10 Continue with “Migrating Your Exchange System to GroupWise 7” on page 27.
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1.4  Exchange Migration Planning Worksheet

Item Explanation

1) Migration Type:

• Single stage

• Multiple stages

Mark whether you can complete the migration in a single stage or 
whether the migration will be a multi-stage process that requires the 
Exchange Gateway.

See Section 1.2.1, “Determining Migration Scope,” on page 10.

2) Migration Utility Usage:

• Single session

• Multiple sessions

Mark whether you can complete the migration using a single session of 
the Migration Utility on a single workstation or whether you need 
multiple workstations with multiple Migration Utility sessions running 
simultaneously.

See Section 1.2.1, “Determining Migration Scope,” on page 10.

3) Exchange Version:

• 5.5

• 2000/2003

Mark the version of Exchange you are migrating from.

See Section 1.2.2, “Gathering Information about Your Exchange 
System,” on page 11.

4) Exchange System 
Information:

• Exchange servers

• Number of mailboxes

• Mailbox names

• Size of Exchange data

• Public folder server

Record the information about your Exchange system that you need 
during the migration process. Use the Exchange to GroupWise User 
List to list the Exchange servers.

See Section 1.2.2, “Gathering Information about Your Exchange 
System,” on page 11.

5) Exchange Administrator 
Information:

• Username

• Password

• MAPI profile

Record the authentication information that the Migration Utility needs in 
order to access the Exchange servers.

See Section 1.2.2, “Gathering Information about Your Exchange 
System,” on page 11.

6) GroupWise System 
Information:

• Post offices

• Domains

• Servers

• Post office directories

• Domain directories

Record the information about the destination GroupWise system. Use 
the Exchange to GroupWise User List to list the post offices.

See Section 1.2.3, “Planning Your GroupWise System,” on page 12.

7) Internet Domain Name: Specify the Internet domain name of your Exchange system. The same 
Internet domain must be used for your GroupWise system if you want 
users to be able to reply to and forward messages after they have been 
migrated.

See Section 1.2.3, “Planning Your GroupWise System,” on page 12.
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8) Resources for Public Folders: Specify the names of the resources that  you want to own the migrated 
Exchange public folders.

See Section 1.2.3, “Planning Your GroupWise System,” on page 12.

9) Client Software Distribution:

• Client CD

• AutoUpdate

• SetupIP

• ZENworks Desktop 
Management

Mark how you want to distribute the GroupWise Windows client 
software to users.

Section 1.2.3, “Planning Your GroupWise System,” on page 12.

10) eDirectory Tree Name:

• Username

• Password

Specify the name of the eDirectory tree where you want to create your 
GroupWise system or where a GroupWise system already exists to 
which the Exchanges users will be added. Make sure you have a user 
with sufficient rights to create containers and other objects.

See Section 1.2.4, “Preparing eDirectory for Your GroupWise System,” 
on page 14.

11) Post Office and Domain 
Contexts:

Specify the eDirectory contexts where you plan to create Post Office 
objects and Domain objects.

Section 1.2.4, “Preparing eDirectory for Your GroupWise System,” on 
page 14.

12) User and Distribution List 
Contexts:

Specify the eDirectory contexts where User objects and Distribution 
List objects will be created.

See Section 1.2.4, “Preparing eDirectory for Your GroupWise System,” 
on page 14.

13) User Object Creation:

• Manually in advance

• Automatically by the 
Migration Utility

Mark whether you want to create User objects in advance or whether 
you want the Migration Utility to create the User objects automatically 
during migration.

See Section 1.2.4, “Preparing eDirectory for Your GroupWise System,” 
on page 14.

14) eDirectory Account File: List the names of the eDirectory account files you plan to use to 
migrate users and distribution lists from one Exchange server to 
multiple eDirectory contexts.

See Section 1.2.4, “Preparing eDirectory for Your GroupWise System,” 
on page 14.

15) Migration Options

• Root folder (Exchange)

• Default password

• Outlook Inbox into 
GroupWise Mailbox

• Outlook Drafts into 
GroupWise Work in 
Progress

Specify the options you want to use for the migration.

See Section 1.2.5, “Determining Migration Results,” on page 16.

Item Explanation
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1.5  Exchange to GroupWise User List

16) Migration Filter

• Items older than

• Deleted items

• Sent Items

• Journal

Mark which items you want to filter out of the migration. If you want to 
filter out older items, specify the date before which you want items to 
be filtered out.

See Section 1.2.5, “Determining Migration Results,” on page 16.

Item Explanation
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1.6  Exchange Migration Quick Checklist
Mailboxes

From Exchange Server: _______________________________________________

To GroupWise Post Office: ____________________________________________

Plan the migration for users on the Exchange server listed above, including Exchange Gateway 
setup if necessary, and creation of eDirectory contexts, User objects, and GroupWise accounts 
as needed. You can list users and contexts on the Exchange to GroupWise User List.

See Section 1.2, “Planning Your Migration from Exchange to GroupWise,” on page 10
Install the Migration Utility on one or more Windows workstations.
See Section 1.3, “Installing the Migration Utility,” on page 20.
Make sure that the Outlook Collaboration Data Objects module is installed where you installed 
the Migration Utility.
See Section 2.1.1, “Checking for the Outlook Collaboration Data Objects Module,” on page 27
Set up administrative access to the Exchange server.
See Section 2.1.2, “Designating a Service Account Administrator on Exchange 5.5,” on 
page 28 or Section 2.1.3, “Ensuring Administrative Rights on Exchange 2000/2003,” on 
page 29.
Set up mailbox access in the Exchange system.
See Section 2.1.4, “Setting Up a MAPI Profile,” on page 29.
Set up eDirectory in preparation for creating the GroupWise system into which you will 
migration the Exchange users.
See Section 2.2.1, “Setting Up eDirectory for Your GroupWise System,” on page 32 and 
Section 2.2.2, “Creating eDirectory Account Files,” on page 33.
Create your GroupWise system.
Section 2.2.3, “Setting Up Your GroupWise System,” on page 33.
If you need a multi-stage migration, install the GroupWise Gateway for Microsoft Exchange.
Section 2.2.4, “Setting Up the Exchange Gateway between Systems,” on page 34.
Before your first migration session, configure GroupWise so that users can successfully reply 
to and forward messages after they are migrated.
See Section 2.2.5, “Establishing Internet Connectivity,” on page 35
Handle the incoming Internet messages that might arrive during the migration.
Section 2.3, “Routing Messages between the Two Systems during the Migration,” on page 37.
Migrate users from the Exchange server to the GroupWise post office listed above.
See Section 2.5.1, “Migrating Exchange Mailboxes,” on page 40.
Migrate to additional post offices as needed.
Section 2.5.2, “Migrating Exchange Mailboxes Using Multiple Sessions,” on page 44.
After your last mailbox migration session, migrate distribution lists/groups and public folders.
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Distribution Lists/Groups

After migrating all mailboxes:

Use any convenient machine for this Migration Utility session.
Map drives to locations of the .uct files created during mailbox migrations.
Migrate the Exchange distribution lists/groups into your GroupWise system.
See Section 2.5.3, “Migrating Exchange Distribution Lists/Groups,” on page 45.

Public Folders

After migrating all mailboxes and distribution lists/groups:

Use any convenient machine for this Migration Utility session.
Migrate the Exchange public folders into your GroupWise system.
See Section 2.5.4, “Migrating Exchange Public Folders,” on page 47.
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2Migrating Your Exchange System 
to GroupWise 7

Before you start the migration process, both the Novell® GroupWise® system and the Microsoft 
Exchange system should be running smoothly. Then complete the following tasks to migrate your 
users from Exchange to GroupWise:

• Section 2.1, “Preparing Your Exchange System for the Migration,” on page 27
• Section 2.2, “Preparing Your GroupWise System for the Migration,” on page 32
• Section 2.3, “Routing Messages between the Two Systems during the Migration,” on page 37
• Section 2.4, “Starting the Migration Utility,” on page 39
• Section 2.5, “Using the Migration Utility,” on page 40
• Section 2.6, “Performing Post-Migration Tasks,” on page 48

2.1  Preparing Your Exchange System for the 
Migration
Your Exchange system and each Migration Utility workstation must be properly set up before you 
start the migration.

• Section 2.1.1, “Checking for the Outlook Collaboration Data Objects Module,” on page 27
• Section 2.1.2, “Designating a Service Account Administrator on Exchange 5.5,” on page 28
• Section 2.1.3, “Ensuring Administrative Rights on Exchange 2000/2003,” on page 29
• Section 2.1.4, “Setting Up a MAPI Profile,” on page 29
• Section 2.1.5, “Cleaning Up Mailboxes,” on page 30
• Section 2.1.6, “Migrating Personal Address Books,” on page 32
• Section 2.1.7, “Backing Up Your Exchange System,” on page 32

2.1.1  Checking for the Outlook Collaboration Data Objects 
Module
Some versions of Outlook install the Collaboration Data Objects (CDO) module by default and 
some do not. The Migration Utility requires that the CDO be installed on each workstation where it 
runs. 

1 In the Windows Control Panel, double-click Add/Remove Programs.
2 Select the Microsoft Office entry, then click Change.
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3 Click Next, then expand the Microsoft Outlook for Windows entry.

If a red X appears beside the Collaboration Data Objects item in the list, then the CDO has not 
been installed.

4 If necessary, select Run from My Computer in the drop-down list for Select Collaboration Data 
Objects, then click Update to install the CDO component.

5 Repeat Step 1 through Step 4 on each Migration Utility workstation.

2.1.2  Designating a Service Account Administrator on 
Exchange 5.5
The Migration Utility needs full access to your Exchange 5.5 system. Therefore, the user who runs 
the Migration Utility must be set up as a Service Account Administrator in your Exchange 5.5 
system.

1 In Exchange Administrator, select an Exchange Domain object, then click File > Properties.
2 On the Permissions tab, select the user account that you plan to log in as when you run the 

Migration Utility (worksheet item 5).

IMPORTANT: The workstation where you run the Migration Utility must have a username 
and password identical to the one you select on the Permissions tab. Otherwise, you cannot 
access the Exchange server with the necessary rights.
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3 In the Roles field, select Service Account Administrator.
4 Click OK to grant the rights to the selected user.
5 Restart the Information Store service.

5a In the Windows Services window, select Microsoft Exchange Information Store.
5b Click Actions > Restart.

6 Repeat Step 1 through Step 5 for each domain in your Exchange system.

2.1.3  Ensuring Administrative Rights on Exchange 2000/2003
The Migration Utility needs full access to your Exchange 2000/2003 system. Therefore, the user 
who runs the Migration Utility must be set up with sufficient rights in your Exchange 2000/2003 
system.

1 In Exchange System Manager, right-click an Exchange Server object, then click Properties.
2 On the Security tab, select the user account that you plan to log in as when you run the 

Migration Utility (worksheet item 5).

IMPORTANT: The workstation where you run the Migration Utility must have a username 
and password identical to the one you select on the Permissions tab. Otherwise, you cannot 
access the Exchange server with the necessary rights.

3 Make sure that all the check boxes in the Allow column are selected, then click OK.
4 Repeat Step 1 through Step 3 for each Exchange server in your system.

2.1.4  Setting Up a MAPI Profile
Setting up a MAPI profile provides login information so the Migration Utility can access a specific 
Exchange server. You need to create a MAPI profile for each Exchange server in your system so that 
the Migration Utility can access it.

1 In the Windows Control Panel, double-click Mail, click Show Profiles, then click Add.
2 Provide a name for the new profile (worksheet item 5), then click OK.
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3 Select Add a New E-Mail Account, then click Next.
4 Select Microsoft Exchange Server, then click Next.

5 Provide login information for the Exchange server:
5a Specify the name of the Exchange server from which you are migrating users.
5b Specify a mailbox name on that server (worksheet item 4).

You can use your mailbox name, your username, or someone else’s as long as the mailbox 
resides on that Exchange server.

5c Click Check Name to make sure that the login information is accurate.
If the name check fails, the Migration Utility cannot access your Exchange system.

5d Click Next.
6 Click Finish.

The new profile now appears in the profile list.
7 Select Prompt for a Profile To Be Used, then click OK.
8 Repeat Step 1 through Step 7 for each Exchange server in your system.

2.1.5  Cleaning Up Mailboxes
Cleaning up Exchange mailboxes streamlines the migration process. It reduces the amount of data to 
migrate and it ensures that the data to migrate is in a valid format that the Migration Utility can 
process.

• “Personal Mailbox Cleanup” on page 30
• “Administrator Cleanup” on page 31
• “Information Store Cleanup” on page 31
• “Private and Public Store Cleanup” on page 31

Personal Mailbox Cleanup

Ask your users to clean up their Exchange mailboxes by deleting and archiving as many messages as 
possible. The less data there is to migrate, the more quickly the migration is finished.
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Administrator Cleanup

As an administrator, delete any unused mailboxes, distribution lists/groups, and public folders. 

Information Store Cleanup

To help minimize data corruption during the migration, clean up the information store by running 
ESEUtil on each server's priv.edb and pub.edb files. This compresses and defragments the 
files. Run the utility on one database at a time.

1 Perform an information store backup before running any maintenance on Exchange databases.
2 Shut down all Exchange agents before running ESEUtil.

In Exchange 5.5, ESEUtil is located in the Winnt/System32 folder. In Exchange 2000/
2003,  it is located in the Exchsrvr/bin folder.

3 From the command prompt in the c:\exchsrvr\bin directory (or wherever the Exchange 
server is installed), run the following commands:
eseutil /d path_to_.edb_files
eseutil /d /exchsrvr/mdbdata/priv.edb

4 To verify that priv  and pub information stores are not corrupt, run ESEUtil with the /r 
switch:
eseutil /r /exchsrvr/mdbdata/priv.edb

5 Start all Exchange services and verify that the Exchange system is running smoothly.
6 When you are satisfied that system is up and running without problems, perform another 

information store backup.
7 Repeat Step 1 through Step 6 for each Exchange server in your system.

Private and Public Store Cleanup

As an administrator, you should also run ISInteg against the databases on Private and Public Stores. 
ISInteg makes sure Exchange messages are consistent and fixes the integrity of the information 
store. Run this utility repeatedly until no errors are found.

1 Start the Information Store Service and dismount the databases. 

You can check only databases that are offline.
2 Stop the Information Store Service.

This also stops the Exchange Events Service.
3 At an Exchange  5.5 server, run the following command to fix problems with information 

stores:
c:\exchsrvr\bin\isinteg -pri -dump -fix -test alltests

or
At an Exchange 2000/20003 server, run the following command:
c:\program files\exchsrvr\bin\isinteg -s ServerName -fix -test
                                                          alltests

For additional ISInteg options, run isinteg.exe /? at the command prompt. See 
Microsoft Technical document Q301460.
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Additional information about using ISInteg can be found in the Isinteg.doc file located on 
the Exchange Server CD in the /server/support/utils folder.

4 Repeat Step 1 through Step 3 for each Exchange server in your system.

2.1.6  Migrating Personal Address Books
The Migration Utility does not migrate Personal Address Books (.pab files). Users should transfer 
the contents of Personal Address Books into the Contacts folder or their Outlook mailboxes so that 
the information can be migrated.

2.1.7  Backing Up Your Exchange System
Before starting the migration, make a complete backup of your Exchange system. 

2.2  Preparing Your GroupWise System for the 
Migration
Your GroupWise system must be set up and prepared to receive in incoming Exchange data.

• Section 2.2.1, “Setting Up eDirectory for Your GroupWise System,” on page 32
• Section 2.2.2, “Creating eDirectory Account Files,” on page 33
• Section 2.2.3, “Setting Up Your GroupWise System,” on page 33
• Section 2.2.4, “Setting Up the Exchange Gateway between Systems,” on page 34
• Section 2.2.5, “Establishing Internet Connectivity,” on page 35
• Section 2.2.6, “Creating User Objects in Advance (Optional),” on page 35
• Section 2.2.7, “Creating a Resource to Own Exchange Public Folders,” on page 36
• Section 2.2.8, “Setting Up GroupWise Name Servers,” on page 36
• Section 2.2.9, “Handling Issues in an Existing GroupWise System,” on page 36

2.2.1  Setting Up eDirectory for Your GroupWise System
eDirectoryTM must be set up and container objects created before  you can create  your GroupWise 
system for the migration.

1 If necessary, download eDirectory from the Novell Download page (http://
download.novell.com/index.jsp) and install it according to the instructions provided in Novell 
eDirectory Installation Guide (http://www.novell.com/documentation/edir88/index.html).

2 Create the containers where you plan to create Post Office objects and Domain objects 
(worksheet item 11).

3 Create the containers where you plan to create User objects and Distribution List objects 
(worksheet item 12).

4 If you need to migration users from an Exchange server into multiple eDirectory contexts, 
continue with Creating eDirectory Account Files.
or
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If you do not need multiple contexts, skip to Section 2.2.3, “Setting Up Your GroupWise 
System,” on page 33.

2.2.2  Creating eDirectory Account Files
If you need to migrate users from an Exchange server to multiple eDirectory contexts, create an 
eDirectory account file (worksheet item 14) for that server. It is a simple ASCII text file that lists the 
users and distribution lists, along with their eDirectory contexts. The Migration Utility expects each 
line to provide two pieces of information, separated by a tab:

user_ID context
distribution_list context

For easiest access, create eDirectory account files in the directory where you install the Migration 
Utility on each workstation. 

You need a file for each Exchange server where the users and distribution lists are being migrated to 
multiple contexts. Make sure that the contexts you list in the file already exist in eDirectory. The 
Migration Utility does not create new contexts.

IMPORTANT: If User objects already exist in your system, make sure that you provide the correct 
context for those users. If the Migration Utility uses one context for a user and an existing User 
object resides in a different context, duplicate users result.

You should already have used the Exchange to GroupWise User List to list users and contexts for 
each post office. Make sure that the list is complete. Users not on the eDirectory account list are 
created in the default eDirectory context.

If you have a large Exchange system, you can use Microsoft Exchange Administrator to generate a 
list of Exchange users’ mailboxes to help you create the eDirectory account files.

1 In Exchange Administrator, expand the site, then click Configuration > Servers.
2 Select the Exchange server that you want to export account information from, then click 

Expand Private Information > Mailbox Resources.
3 Click anywhere in the right pane, then click File > Save Window Content.
4 Provide a filename, indicate where to save the file, then click Save.
5 Print a copy of the file to work with.

or
Edit the file to organize the information.

6 Repeat Step 1 through Step 5 for each Exchange server.
7 Create the eDirectory account files you will use when you run the Migration Utility.
8 Continue with Section 2.2.3, “Setting Up Your GroupWise System,” on page 33

2.2.3  Setting Up Your GroupWise System
You need to set up your full GroupWise system before you start the migration. You can create your 
GroupWise system on any supported GroupWise platform (NetWare®, Linux, or Windows). 
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IMPORTANT: Make sure you have the latest GroupWise 7 Support Pack.

1 Install a basic GroupWise system, as described in “Installing a Basic GroupWise System” in 
the GroupWise 7 Installation Guide.

This includes installing the GroupWise Administrator snap-in to ConsoleOne®, creating a 
domain and post office, and installing the Message Transfer Agent (MTA) and the Post Office 
Agent (POA).

2 During installation, create a software distribution directory with at least the GroupWise client 
software.

3 In ConsoleOne, create the GroupWise domains  (worksheet item 6) that will house the post 
offices for the migrated Exchange users, as described in “Creating a New Domain” in 
“Domains” in the GroupWise 7 Administration Guide.

4 At each domain server, install and start the  MTAs for the domains, as described in “Installing 
GroupWise Agents” GroupWise 7 Installation Guide.

5 In ConsoleOne, create the GroupWise post offices (worksheet item 6) for the migrated 
Exchange users, as described in “Creating a New Post Office” in “Post Offices” in the 
GroupWise 7 Administration Guide.

IMPORTANT: Leave  the post office security level set to the default of Low.  

6 At each post office server, install  and start the POAs for the post offices, as described in 
“Installing GroupWise Agents” GroupWise 7 Installation Guide.

7 If you are performing a multi-stage migration, continue with Setting Up the Exchange Gateway 
between Systems
or
Skip to Section 2.2.5, “Establishing Internet Connectivity,” on page 35.

2.2.4  Setting Up the Exchange Gateway between Systems
If you are performing a single-stage migration, you do not need to use the Exchange Gateway. But if 
you need to perform a multi-stage migration (worksheet item 1), you must set up the Exchange 
Gateway to connect your existing Exchange system with your new GroupWise system so that mail 
continues to flow while some users are still on Exchange and some users have been migrated to 
GroupWise. The gateway also keeps Address Books synchronized, so that changes in one system are 
replicated to the other system.

Install and start the Exchange Gateway with directory synchronization and exchange enabled before 
you install and run the Migration Utility. This creates a representation of your Exchange system in 
your GroupWise system. Each Exchange server is represented by a GroupWise external post office. 
The external post offices all belong to an external domain that represents your Exchange system.

The Exchange Gateway is available on the Novell Downloads page (http://download.novell.com/
pages/PublicSearch.jsp). Documentation for the Exchange Gateway is available on the GroupWise 
Gateways Web site (http://www.novell.com/documentation/gwgateways). 

After the gateway is set up and running, continue with Establishing Internet Connectivity.
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2.2.5  Establishing Internet Connectivity
1 Install  and start the Internet Agent, as described in “Installing the GroupWise Internet Agent” 

GroupWise 7 Installation Guide.
2 Enable Internet addressing and set up the Internet domain name  (worksheet item 7) for your 

GroupWise system, as described in “Enabling Internet Addressing” in “Internet Agent”in the 
GroupWise 7 Administration Guide.

3 Set the preferred address format to UserID@Internet_domain_name.
This is the format that most easily ensures uniqueness of users’ Internet addresses. You can 
choose other alternatives, though, as described in “Preferred Address Format” in “Internet 
Agent”in the GroupWise 7 Administration Guide.

4 If you want to create User objects and GroupWise accounts in advance (worksheet item 13), 
continue with Creating User Objects in Advance (Optional).
or
Skip to Section 2.2.7, “Creating a Resource to Own Exchange Public Folders,” on page 36.

2.2.6  Creating User Objects in Advance (Optional)
You can manually create User objects for migrated users (worksheet item 13) in ConsoleOne.

1 Browse to and right-click a container  (worksheet item 12) where you want to create User 
objects, then click New > User.

2 Fill in at least the Name, Surname, and Unique ID fields.
What you type in the Name field transfers automatically to the Unique ID field and becomes 
the user’s username.

3 Select Add User to GroupWise Post Office, then select the user’s post office.
This creates the user’s GroupWise account and mailbox.

4 Fill in other fields as needed.
For complete instructions on creating eDirectory users, see the Novell eDirectory 
Administrator Guide (http://www.novell.com/documentation/edir88/index.html). For more 
information about GroupWise account creation, see “Creating GroupWise Accounts” in 
“Users” in the GroupWise 7 Administration Guide.

5 Click OK to create the User object.

If you have a large number of users, you can use the Import/Export Utility to import users into 
eDirectory from an ASCII-delimited file. For information, see “Import/Export” in “System” in the 
GroupWise 7 Administration Guide.

You can use Microsoft Exchange Administrator to export a list of mailboxes, as described in “User 
and Distribution List Contexts” on page 15.

Another helpful tool is the GroupWise Import Utility (GWIU) by Weisberg Consulting, Inc. (http://
www.weisberg.net/index.html). Additional helpful tools are available at Weisberg Consulting, Inc., 
at Lewis Studios (http://www.slewis.org), and at GroupWise Cool Solutions Downloads (http://
www.novell.com/coolsolutions/gwmag/downloadables.html).

Continue with Creating a Resource to Own Exchange Public Folders.
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2.2.7  Creating a Resource to Own Exchange Public Folders
Create one or more Resource objects  (worksheet item 8) that will own the Exchange public folders 
that become GroupWise shared folders, as described in “Creating Resources”in “Resources”in the 
GroupWise 7 Administration Guide.

Continue with Setting Up GroupWise Name Servers.

2.2.8  Setting Up GroupWise Name Servers
To simplify users’ access to their new GroupWise mailboxes, set up two GroupWise name servers, 
as described in “Simplifying Client/Server Access with a GroupWise Name Server” in “Post Office 
Agent” in the GroupWise 7 Administration Guide.

If you are migrating Exchange users into an existing GroupWise system, continue with Handling 
Issues in an Existing GroupWise System.

If you are performing a multi-stage migration and need to set up the Exchange Gateway, skip to 
Section 2.2.4, “Setting Up the Exchange Gateway between Systems,” on page 34

If neither of these situations applies, you are ready to start your migration. Skip to Section 2.4, 
“Starting the Migration Utility,” on page 39.

2.2.9  Handling Issues in an Existing GroupWise System
If you are migrating Exchange users into an existing GroupWise system, care must be taken with 
existing User objects and existing GroupWise accounts.

• “Handling Existing eDirectory User Objects with Personal Passwords” on page 36
• “Handling Existing GroupWise Accounts with Personal Passwords” on page 37

Handling Existing eDirectory User Objects with Personal Passwords

If the users whose mailboxes are being migrated to GroupWise already have eDirectory User objects 
with personal passwords already set, the security level on the post office to which the users are being 
migrated is important. You can check the security setting in ConsoleOne:

1 Browse to and right-click the Post Office object, then click Properties.
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2 Click GroupWise > Security.

If Security Level is set to Low or High, or if eDirectory Authentication is selected, the 
Migration Utility can add GroupWise accounts to existing User objects as they are added to the 
post office. However, if LDAP Authentication is selected, the Migration Utility cannot add 
GroupWise accounts because the Migration Utility cannot perform LDAP authentication.

3 If LDAP Authentication is selected, select a different security option, then click OK to save 
your change.

4 After all Exchange users have been migrated to the post office, return to ConsoleOne and select 
LDAP Authentication again.

Handling Existing GroupWise Accounts with Personal Passwords

You cannot use the Migration Utility to migrate data from a mailbox in an Exchange system into an 
existing GroupWise mailbox that has a personalized password that does not match the default 
password used by the Migration Utility. To accomplish this task, the user can use Microsoft Outlook 
to save all data from the Exchange mailbox into a PST file, then use the GroupWise Import Utility 
for Microsoft Outlook to import the Exchange data into the existing GroupWise mailbox. For 
instructions, see Chapter 3, “Using the GroupWise 7 Import Utility for Microsoft Outlook,” on 
page 53.

2.3  Routing Messages between the Two Systems 
during the Migration
Whether you are performing a single-stage or a multi-stage migration, there is a period of time when 
mailboxes cannot be accessed because they are being migrated, but Internet mail is still arriving at 
your site. In order to not lose incoming mail during the migration process, you must configure 
routing to direct incoming mail to an appropriate location, taking into account that both e-mail 
systems have the same Internet domain name. Alternatives include:

• Section 2.3.1, “Using a Smart Host,” on page 38
• Section 2.3.2, “Forwarding Undeliverable Messages,” on page 38
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• Section 2.3.3, “Redirecting Messages,” on page 38

2.3.1  Using a Smart Host
If you have an upstream smart host that can queue the mail for delivery after the migration, make 
use of that convenient alternative. If you are using this approach, it does not matter whether you 
have chosen to create eDirectory User objects and GroupWise accounts in advance, as described in 
“User Object Creation” on page 15.

2.3.2  Forwarding Undeliverable Messages
If you do not have a smart host and you are not using a gateway to synchronize user information 
between the two e-mail systems, you can route all inbound messages to the GroupWise system, then 
configure the GroupWise Internet Agent to forward any undeliverable messages to the Exchange 
system. 

This approach does require that you have created eDirectory User objects and GroupWise accounts 
in advance, because incoming messages might need to be delivered into GroupWise accounts before 
the migration has been completed.

1 Make sure that the Internet Agent is installed and running, as described in Section 2.2.5, 
“Establishing Internet Connectivity,” on page 35. 

2 In ConsoleOne, browse to and right-click the Internet Agent object that you want to configure 
for forwarding, then click Properties.

3 Click SMTP/MIME > Undeliverables.
4 In the Forward Undeliverable Inbound Messages to Host field, specify the IP address or 

hostname of an Exchange server that can handle incoming Internet messages.
5 Click OK to save the setting.

ConsoleOne then notifies the Internet Agent to restart to put the new setting into effect.

2.3.3  Redirecting Messages
If you do not have a smart host, and you are using the Exchange Gateway to synchronize user 
information between the two e-mail systems, you can configure the GroupWise Internet Agent to 
redirect mail to the Exchange system for users who have not yet been migrated. Redirected 
messages are not considered undeliverable; they are accepted by the Internet Agent and passed 
along to a specified host.

This approach does require that you have created eDirectory User objects and GroupWise accounts 
in advance, because incoming messages might need to be delivered into GroupWise accounts before 
the migration has been completed. 

1 Make sure that the Internet Agent is installed and running, as described in Section 2.2.5, 
“Establishing Internet Connectivity,” on page 35. 

2 Create a route.cfg file, as described in “Using a Route Configuration File” in “Internet 
Agent” in the GroupWise 7 Administration Guide.

3 Provide the SMTP hostname and address of an Exchange server that can handle incoming 
Internet messages.

       Syntax: 
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SMTP_hostname     alternative_hostname_or_IP_address

       Example: 
corporate.com     exchange.corporate.com
corporate.co.uk   [172.16.5.18]

Square brackets are required around IP addresses. An empty line is required at the end of the 
file, so that the file ends with a hard return.

4 Save and exit the route.cfg file.
5 Restart the Internet Agent so that it reads the new file.

2.4  Starting the Migration Utility
The first time you run the Migration Utility, you should migrate only a small number of mailboxes. 
This shows you how long it takes to migrate mailboxes on your system with its current 
configuration. This information helps you decide how to implement multiple Migration Utility 
sessions, as described in Section 2.5.2, “Migrating Exchange Mailboxes Using Multiple Sessions,” 
on page 44.

NOTE: If you are migrating to a GroupWise system on Linux, see Appendix B, “Linux Migration,” 
on page 61 before starting the Migration Utility.

1 Make sure that you have Exchange administrator rights (worksheet item 5).
2 Stop incoming message flow to the Exchange server that you are going to migrate, using one of 

the methods described in Section 2.3, “Routing Messages between the Two Systems during the 
Migration,” on page 37 to make sure that no incoming messages are lost during the migration.

3 Ensure that users cannot access their mailboxes during the migration using either Outlook or 
Outlook Web Access.

4 If you are using the Exchange Gateway in a multi-stage migration:
4a In ConsoleOne, disable directory synchronization and exchange on the Optional Gateway 

Settings page of the Exchange Gateway object.
4b For the users being migrated, delete their External User objects from the external post 

office in the external domain that represents the Exchange system.
The existence of the External User objects interferes with the creation of new User objects 
with the same name in the GroupWise system.

5 Log in to the eDirectory tree (worksheet item 10) where you are migrating the Exchange users.
6 Map a drive to a GroupWise domain directory (worksheet item 6).

NOTE: If the domain is located on Linux, you can use a Samba share as described in Appendix 
B, “Linux Migration,” on page 61. 

7 Click Start > Programs > GroupWise > GroupWise Migration Utility for Microsoft Exchange.
or
Double-click the Migration Utility icon created by the Installation program on your desktop.

8 Continue with Using the Migration Utility.
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2.5  Using the Migration Utility
The migration process for your Exchange system is performed in three phases. First, you migrate all 
Exchange mailboxes. Second, you migrate Exchange distribution lists/groups. Third, you migrate 
Exchange public folders. If you are performing a large system migration, you can run the Migration 
Utility on multiple workstations to speed the migration of mailboxes.

• Section 2.5.1, “Migrating Exchange Mailboxes,” on page 40
• Section 2.5.2, “Migrating Exchange Mailboxes Using Multiple Sessions,” on page 44
• Section 2.5.3, “Migrating Exchange Distribution Lists/Groups,” on page 45
• Section 2.5.4, “Migrating Exchange Public Folders,” on page 47

2.5.1  Migrating Exchange Mailboxes
1 If you are running the Exchange Gateway (worksheet item 1):

1a In ConsoleOne, disable directory synchronization and exchange on the Optional Gateway 
Settings page of the Exchange Gateway object.

1b For the users to be migrated, delete the External User objects from the external post office 
in the external domain that represents your Exchange system in your GroupWise system.
The External User objects must be deleted because they interfere with the creation of new 
User objects with the same names in the GroupWise system. 

2 Start the Migration Utility, as described in Section 2.4, “Starting the Migration Utility,” on 
page 39.
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3 Select Mailboxes, then click Next.

4 Fill in the following fields:
Exchange MAPI Profile: Select the Exchange administrator profile (worksheet item 5). You 
can click Create if you have not yet set up the MAPI profile.
GroupWise Domain: Browse to and select the domain directory (worksheet item 6) where the 
GroupWise domain database (wpdomain.db) resides.
GroupWise Post Office: Select the post office (worksheet item 6) where you want to migrate 
the Exchange users. The list offers those post offices that belong to the domain selected above.
Default eDirectory Context: Browse to and select the eDirectory context for User objects 
(worksheet item 12). 
If you have already created the User objects in eDirectory, then the Migration Utility adds 
GroupWise accounts to the User objects, if the existing User object names match the Exchange 
account names. If you have not yet created the User objects, then the Migration Utility creates 
both the User objects and the GroupWise accounts in the context you specify.
eDirectory Account File: If you want to create the User objects in multiple eDirectory 
contexts, browse to and select the eDirectory account file (worksheet item 14) that you 
prepared for this post office.
Any Exchange users not found in the eDirectory account file are placed in the location 
specified in the Default eDirectory Context field.
Create GroupWise External Entities for New Accounts: If you select this option, the 
Migration Utility creates External Entity objects instead of User objects for your Exchange 
users. External entities can be given GroupWise accounts but are not considered eDirectory 
users for licensing purposes.
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5 Click Next to list the users on the Exchange server.

Users marked with <new> do not exist in the post office into which you are migrating users. If 
a user is marked with <exist>, then a GroupWise account for that user ID already exists. 
This is not a problem if both mailboxes belong to the same user; the contents of the Exchange 
mailbox are merged into the contents of the existing GroupWise mailbox. However, if the 
Exchange user ID is already in use in GroupWise by a different user, you must migrate the user 
into a different post office or give the user a new user ID in Exchange and then perform the 
migration.

6 Select the users you want to migrate into the post office, then click Next.

7 Select migration options:
Root Folder Name: Specify the name of the folder in GroupWise (worksheet item 15) that 
will hold the migrated contents of users’ Outlook mailboxes. The default folder name is 
Exchange.
Default Password: Provide a default password for all GroupWise mailboxes (worksheet item 
15) . 

IMPORTANT: Make sure you notify your users what their password is and remind them to 
change it quickly so that users cannot access each others’ mailboxes.

If the Migration Utility is creating both eDirectory User objects and GroupWise accounts, the 
default password is used for both eDirectory and GroupWise. If eDirectory User objects 
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already exist and already have passwords, the existing eDirectory passwords are retained on the 
User objects and the default password is used for the GroupWise mailboxes. For information 
about GroupWise passwords, see “Mailbox Passwords” in “Security Administration” in the 
GroupWise 7 Administration Guide.
Mailbox Items: Select All Items, or select Exclude Messages Before and specify a date 
(worksheet item 16). Messages dated on or after the specified date are migrated to GroupWise. 
Messages dated before the specified date are not migrated to GroupWise.
Migrate Deleted Items: Select this option (worksheet item 16) if you want to migrate deleted 
items into your GroupWise mailbox.
Migrate Sent Items: Select this option (worksheet item 16) if you want to migrate sent items 
into your GroupWise mailbox.
Migrate Journal: Select this option (worksheet item 16) to migrate journal items. The 
GroupWise client does not include the Journal feature. However, if you choose to migrate 
journal items, they are migrated into a Journal folder in the GroupWise mailbox for reference.
The fewer items you migrate, the faster the migration proceeds. If you choose to migrate 
deleted, sent, or journal items, all such items are migrated, regardless of date.
Migrate Inbox into Primary GroupWise Mailbox: Select this option (worksheet item 15) to 
have the messages in each user’s current Outlook Inbox folder automatically appear in the main 
GroupWise Mailbox folder, rather than in the Inbox folder under the root folder specified 
above. Subfolders in each user’s Inbox are still migrated into the root folder, not the GroupWise 
Mailbox folder.
Migrate Drafts into GroupWise Work in Progress: Select this option (worksheet item 15) to 
have the contents of each user’s current Outlook Drafts folder automatically appear in the 
GroupWise Work in Progress folder, rather than in the Drafts folder under the root folder 
specified above.
All other Outlook mailbox contents appear in folders under the root folder specified above.

8 Click Next, then click Start to start the migration.
The Migration Utility log file displays at the end of the migration process. Use the Level drop-
down list (Error, Warning, Verbose, Diagnostic) to control how much information is displayed. 
If a message extends beyond the viewing window, click it to display the full message text.
The Migration Utility log file is named migrate.log and is located in the Migration Utility 
installation directory. To start a new log file, click Clear Log in the Migration Log dialog box. 
This saves the existing log file as migrate.001. The extension increments each time you 
start a new log file.

9 Click Finish when the user migration is complete.
10 If you are running the Exchange Gateway (worksheet item 1):

The Migration Utility creates a gateway.csv file that enables you to update migrated users’ 
auto-forwarding information for Exchange 5.5. The gateway.csv file is a simple comma-
separated values file that updates each Exchange user’s mailbox with the appropriate 
forwarding address. Later versions of Exchange require manual update.
10a For Exchange 5.5, import the gateway.csv file into your Exchange system using 

Exchange Administrator. Click Tools > Directory Import. Specify the gateway domain, 
server, and container (Recipients/GroupWise). Select the gateway.csv file, then click 
Import.
or
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For Exchange 2000/2003, manually update migrated users’ auto-forwarding information 
using Active Directory* Users and Computers. Double-click each Exchange user, then 
select Delivery Options. Select the newly migrated GroupWise user as the Alternate 
Recipient.

10b In ConsoleOne, enable directory synchronization and exchange on the Optional Gateway 
Settings page of the Exchange Gateway object.

10c Delete the gateway status correlation database (gwcorr.db) in the gateway installation 
directory, then delete any files in the Exchange Gateway’s ds and dx subdirectories.
This cleanup assures a clean synchronization between systems.

10d Stop and then start the Exchange Gateway, which causes an immediate directory 
synchronization and exchange.
This directory synchronization and exchange notifies your Exchange system about the 
new GroupWise users that have just been migrated into the GroupWise system.

10e In ConsoleOne, disable directory synchronization and exchange on the Optional Gateway 
Settings page of the Exchange Gateway object.

11 Repeat Step 1 through Step 10 until you have migrated all of your Exchange users.
The more sessions of the Migration Utility you run concurrently, the faster the process moves 
along. See Section 2.5.2, “Migrating Exchange Mailboxes Using Multiple Sessions,” on 
page 44 for suggestions on speeding up the migration.

When you have migrated all of your Exchange users to GroupWise, you are ready to migrate 
Exchange distribution lists/groups. Distribution lists/groups can be migrated in one session per 
GroupWise post office. Skip to Section 2.5.3, “Migrating Exchange Distribution Lists/Groups,” on 
page 45

2.5.2  Migrating Exchange Mailboxes Using Multiple Sessions
For a large system migration, you can run Migration Utility sessions simultaneously on multiple 
workstations. Because the Migration Utility is CPU-intensive, you might want to install and run 
each Migration Utility session on a different workstation. However, you can run multiple sessions 
on the same workstation if sufficient system resources are available.

For a large system migration, you can preconfigure each Migration Utility session before you 
actually start the migration. To accomplish this, you can run the Migration Utility at each location up 
until you would click Start to perform the migration. This creates a migration control file named 
ExchMig.uct that contains a list of users to be migrated and where each mailbox will be 
migrated. A comfortable number of users to migrate per session is around 100. The migration  
control file is created in the Migration Utility installation directory  and can be viewed in a text 
editor such as Notepad. It is similar in format to a Windows .ini file. When you are ready to 
actually perform the migration, go to each location, run through the Migration Utility, and accept the 
preconfigured information provided by the ExchMig.uct file, then click Start.

If you want to run multiple sessions on the same workstation, you must set up unique locations for 
migration control files. To accomplish this, create a Migration Utility icon on your desktop. Edit its 
properties, and in the Target field, add a path where you want that session of the Migration Utility to 
create its .uct file. For example you could create three control file directories (c:\mig1, 
c:\mig2, and c:\mig3) and create three desktop icons with the following target lines:

“c:\Program Files\
Novell\GroupWise Migration Utility for Microsoft
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                                        Exchange\exchldr.exe” c:\mig1
“c:\Program Files\

Novell\GroupWise Migration Utility for Microsoft
                                        Exchange\exchldr.exe” c:\mig2
“c:\Program Files\

 Novell\GroupWise Migration Utility for Microsoft
                                        Exchange\exchldr.exe” c:\mig3

Start each session using its customized desktop icon, then let them run concurrently. Check the 
Performance tab of the Windows Task Manager periodically to ensure that the workstation is not 
becoming overloaded.

An advantage to running multiple Migration Utility sessions is that if one session must be stopped, it 
does not halt the entire migration process. When you restart a session, the Migration Utility picks up 
where it left off. It does not need to start over at the top of the list of users to migrate.

2.5.3  Migrating Exchange Distribution Lists/Groups
Exchange 5.5 distribution lists and Exchange 2000/2003 groups are parallel to GroupWise 
distribution lists, both of which are publicly available groups of users created by an administrator. 
All mailboxes must be migrated before you migrate distribution lists/groups because users must be 
added to distribution lists/groups based on their new GroupWise locations, not on their old 
Exchange locations. Although it probably required multiple session to migrate mailboxes, migration 
of all distribution lists/groups can be accomplished in just one session unless you want to spread 
your distribution lists/groups across multiple post offices.

1 Map a drive to each workstation where you ran the Migration Utility to migrate users.

In order to migrate distribution lists/groups, the Migration Utility needs access to all of the 
.uct files that were created during mailbox migration, or at least all the .uct files that 
contain distribution lists that you want to migrate into the current destination post office.

2 Start the Migration Utility, as described in Section 2.4, “Starting the Migration Utility,” on 
page 39.

3 In the main Migration Utility dialog box, select Distribution Lists/Groups, then click Next.

4 Fill in the following fields:
Exchange MAPI Profile: Select the Exchange administrator profile (worksheet item 5).
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GroupWise Domain: Browse to and select the domain directory (worksheet item 6) where the 
GroupWise domain database (wpdomain.db) resides.
GroupWise Post Office: Select the post office (worksheet item 6) where you want to migrate 
the distribution lists/groups.
Default eDirectory Context: Browse to and select the eDirectory context (worksheet item 12) 
for Distribution List objects. 
eDirectory Account File: If you want to create the Distribution List objects in multiple 
eDirectory contexts, browse to and select the eDirectory account file (worksheet item 14).

5 Click Next to list all distribution lists/groups listed in the .uct files that you made available to 
the Migration Utility in Step 1.

Distribution lists/groups marked with <new> do not exist in the post office into which you are 
migrating them. If a distribution list/group is marked with <exist>, then a GroupWise 
distribution list by that name already exists. This is not a problem if you want to merge the 
contents of the Exchange distribution list/group into the contents of the existing GroupWise 
distribution list. If you do not want this to happen, then rename one of the distribution lists so 
that the names are unique. 

6 Select the distribution lists you want to migrate into the current destination post office, then 
click Next to provide the required information about the Exchange users you have moved to 
GroupWise.
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7 Click Add, then browse to and select the .uct file created during each user migration session.

8 Repeat Step 7 for each .uct file that you made available to the Migration Utility in Step 1.
9 When your list of the .uct files is complete, click Next, then click Start to perform the 

distribution list migration.
10 Click Finish when the distribution list migration is complete.

NOTE: Exchange distribution lists/groups that are nested within distribution lists/groups are 
not migrated. Therefore, you must manually reconstruct nested distribution lists, as described 
in “Fixing Nested Distribution Lists” on page 49.

11 If you are migrating your Exchange distribution lists/groups into multiple GroupWise post 
offices, repeat Step 2 through Step 10 for each post office.

When you have migrated all of your Exchange distribution lists/groups to GroupWise, you are ready 
to migrate public folders. Public folders can be migrated in one session if you have only one public 
folder server in your Exchange system.

2.5.4  Migrating Exchange Public Folders
Exchange public folders are similar to GroupWise shared folders. If you have one public folder 
server, all public folders are migrated into the same post office. If you have public folders on 
multiple Exchange servers, you can choose to migrate them all into one post office or you can 
choose to migrate them into different post offices, depending on which users access which public 
folders most frequently.

Exchange provides a public location for public folders, but when you migrate them to GroupWise, 
the public folders are owned by GroupWise resources. The Migration Utility automatically sets up 
shared folder access as close as possible to the public folders in the Exchange system by applying 
the Access Control List (ACL) share rights out to the GroupWise users that originally had rights to 
the public folders in the Exchange system.

IMPORTANT: Migrate public folders only once. If you repeat the public folder migration session, 
duplicate shared folders are created.

1 Start the Migration Utility, as described in Section 2.4, “Starting the Migration Utility,” on 
page 39.
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2 In the main Migration Utility dialog box, select Public Folders, then click Next.

3 Fill in the following fields:
Exchange MAPI Profile: Select the Exchange administrator profile you created (worksheet 
item 5).
GroupWise Domain: Browse to and select the domain directory (worksheet item 6) where the 
GroupWise domain database (wpdomain.db) resides.
GroupWise Post Office: Select the post office (worksheet item 6) where you want to migrate 
the Exchange public folders.
GroupWise Owner (User ID and Password): Provide the name of the resource (worksheet 
item 8) that you want to own the GroupWise shared folders that correspond to the Exchange 
public folders. 

IMPORTANT: Resources do not have passwords, so leave the Password field empty.

4 Click Next, then click Start to perform the public folder migration.
5 Click Finish when the public folder migration is complete.
6 Repeat  Step 1 through Step 5 for each Exchange server where there are public folders.
7 Continue with Performing Post-Migration Tasks.

2.6  Performing Post-Migration Tasks
After you have finished running the Migration Utility, there are a few loose ends to tie up in order to 
complete the migration.

• Section 2.6.1, “GroupWise Post-Migration Tasks,” on page 49
• Section 2.6.2, “Exchange Post-Migration Tasks,” on page 50

After you have performed the post-migration tasks, you have finished your part in the migration 
from Exchange to GroupWise, but your users still have some work to do. As an administrator, you 
can help users adapt to GroupWise, as described in Chapter 3, “Using the GroupWise 7 Import 
Utility for Microsoft Outlook,” on page 53.
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2.6.1  GroupWise Post-Migration Tasks
• “Distributing and Installing the GroupWise Windows Client” on page 49
• “Distributing and Installing the GroupWise Import Utility for Microsoft Outlook” on page 49
• “Fixing Nested Distribution Lists” on page 49
• “Configuring Your GroupWise System” on page 50
• “Providing Additional GroupWise Client Alternatives” on page 50

Distributing and Installing the GroupWise Windows Client

During or after the migration, install the GroupWise Windows client on users’ workstations using 
your chosen distribution method (worksheet item 9), as described in “Distributing the GroupWise 
Client” in “Client” in the GroupWise 7 Administration Guide.

Have users log in and review the contents of their GroupWise mailboxes to ensure that the expected 
items are present. Make sure that they can reply to and forward messages. Make sure that 
appointments are set for the correct time. Let users of public folders know that they will receive 
notifications that they must accept in order to continue participating in the corresponding 
GroupWise shared folders.

Distributing and Installing the GroupWise Import Utility for Microsoft Outlook

Promptly distribute the GroupWise Import Utility for Microsoft Outlook to your users so that they 
can import their Outlook PST files into their GroupWise mailboxes. Depending on the needs of your 
users, you could:

• Provide a network installation of the Import Utility that users could run
• E-mail the Import Utility to users so they can install it on their own workstations
• Provide them with the URL for the Novell Downloads page (http://download.novell.com) 

where they can download the Import Utility for themselves
• Install the Import Utility as an add-on program along with the GroupWise Windows client, as 

described in “Modifying the addon.cfg File” in “Client” in the GroupWise 7 Administration 
Guide

To help users adjust to GroupWise, make sure that they have access to the GroupWise 7 Import 
Utility for Microsoft Outlook Quick Start (ImportUtilityQuickStart.pdf). It is available 
in the installation directories of both the Migration Utility and the Import Utility. You might want to 
print copies for your users to help them get comfortable in their GroupWise mailboxes as quickly as 
possible. For your convenience, the same information is presented in Chapter 3, “Using the 
GroupWise 7 Import Utility for Microsoft Outlook,” on page 53 in this guide.

Fixing Nested Distribution Lists

If you had nested distribution lists/groups in your Exchange system, use ConsoleOne to set them up 
in your GroupWise system the way they were in your Exchange system.

See “Adding Members to a Distribution List” in “Distribution Lists, Groups, and Organizational 
Roles” in the GroupWise 7 Administration Guide.
Migrating Your Exchange System to GroupWise 7 49

http://download.novell.com


50 GroupWise 

novdocx (E
N

U
)  01 February 2006
Configuring Your GroupWise System

Configure your GroupWise system of migrated Exchange users just as you would any other system. 
The GroupWise 7 Administration Guide provides complete instructions. Review each part of the 
guide to determine what tasks you need to perform to secure and optimize your GroupWise system. 
Important tasks include:

• “Providing LDAP Authentication for GroupWise Users”
• “Managing Disk Space Usage in the Post Office”
• “Maintaining User/Resource and Message Databases”
• “Using eDirectory User Synchronization”
• “Enabling Intruder Detection”
• “Blocking Unwanted E-Mail from the Internet”
• “Enhancing Post Office Security with SSL Connections to the POA”
• “Enhancing Domain Security with SSL Connections to the MTA”
• “Securing Internet Agent Connections with SSL”
• “Securing WebAccess Agent Connections with SSL”
• “Using GroupWise Monitor”

To ensure a secure system, see “Security Policies” in the GroupWise 7 Administration Guide.

Providing Additional GroupWise Client Alternatives

Although the GroupWise Windows client is required for use with the GroupWise Import Utility for 
Microsoft Exchange, users can choose among various clients for long-term use:

• WebAccess client, as described in “Installing GroupWise WebAccess” in the GroupWise 7 
Installation Guide

• Cross-Platform client for use on Linux and Macintosh, as described in “Setting Up the 
GroupWise Cross-Platform Client on Linux” and “Setting Up the GroupWise Cross-Platform 
Client on Macintosh”

• GroupWise Connector for Microsoft Outlook, as described in Outlook Connector Quick Start 
(http://www.novell.com/documentation/gw7/outlookconquickstart/data/aiw00yd.html)

• POP and IMAP clients, as described in “Configuring POP3/IMAP4 Services” in “Internet 
Agent” in the GroupWise 7 Administration Guide

2.6.2  Exchange Post-Migration Tasks
• “Removing Migrated Mailboxes” on page 50
• “Disabling Exchange Logon” on page 51
• “Using Outlook and GroupWise on the Same Workstation” on page 51

Removing Migrated Mailboxes

If you are running the Exchange Gateway and you are performing a multi-stage migration, you must 
remove the Exchange mailboxes of users who have already been migrated so that new messages are 
delivered to the GroupWise mailboxes and not the Exchange mailboxes.
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Disabling Exchange Logon

If you are not using the Exchange Gateway, disable users’ log on so that users do not accidentally 
access their Exchange mailboxes instead of their GroupWise mailboxes. 

Using Outlook and GroupWise on the Same Workstation

If some users want to run Outlook after GroupWise has been installed on their workstations, they 
must configure Outlook to prompt for a profile at startup. Otherwise, the GroupWise profile is used 
by default.

Also, these users should use the GroupWise Connector for Microsoft Outlook, as described in the 
GroupWise Connector for Microsoft Outlook Quick Start (http://www.novell.com/documentation/
gw7/outlookconquickstart/data/aiw00yd.html).
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3Using the GroupWise 7 Import 
Utility for Microsoft Outlook

As soon as your system administrator has migrated your e-mail system from Microsoft Exchange to 
Novell® GroupWise® 7, you can use the GroupWise Import Utility for Microsoft Outlook to import 
personal information from Outlook PST (Personal Folder Storage) files on your workstation into 
your GroupWise mailbox or archive. The following tasks help you install and run the GroupWise 
Import Utility, explain some of the differences you might notice between GroupWise and Outlook, 
and lead you to additional information about using GroupWise as your e-mail and collaboration tool.

• Section 3.1, “Meeting Import Utility System Requirements,” on page 53
• Section 3.2, “Installing the GroupWise 7 Windows Client,” on page 53
• Section 3.3, “Installing the GroupWise Import Utility for Microsoft Outlook,” on page 53
• Section 3.4, “Accessing Your GroupWise Mailbox,” on page 54
• Section 3.5, “Importing Outlook PST Files into GroupWise,” on page 55
• Section 3.6, “Getting Acquainted with GroupWise,” on page 56
• Section 3.7, “Adapting to Differences between GroupWise and Outlook,” on page 57

3.1  Meeting Import Utility System Requirements
The workstation where you want to run the GroupWise Import Utility must have the following 
versions of both e-mail clients installed:

• Microsoft Outlook 2002 client with Service Pack 1 or later
• GroupWise 7 Windows client or later 

3.2  Installing the GroupWise 7 Windows Client
After your system administrator has migrated your Exchange system to GroupWise and provided the 
GroupWise Windows client software, you can begin using the GroupWise Windows client. Refer to 
the GroupWise 7 Quick Start (http://www.novell.com/documentation/gw7/pdfdoc/gw7_qs/
gw7_qs.pdf) for basic installation instructions. Your system administrator might have already 
installed the GroupWise client software for you.

If you want to use the GroupWise 7 Cross-Platform client on Linux or Macintosh* rather than the 
GroupWise Windows client, you can do so after using the Windows client to import your PST files.

3.3  Installing the GroupWise Import Utility for 
Microsoft Outlook
When you first start the GroupWise client, your mailbox contains all the items that were migrated 
from your Outlook mailbox on the Exchange server into your GroupWise mailbox. It does not 
contain items that you have saved elsewhere in Outlook PST files. The GroupWise Import Utility 
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helps you complete the migration process by bringing your personal information into your 
GroupWise mailbox or archive.

To install the GroupWise Import Utility:

1 Obtain the utility from one of the following sources:
• Your system administrator might provide the utility for you.
• You can download the utility from the Novell Downloads page (http://

download.novell.com/pages/PublicSearch.jsp).
2 Save the setup.exe file for the GroupWise Import Utility to a convenient location.
3 Make sure you are not running the Windows GroupWise client while you install the Import 

Utility.
4 Run setup.exe, then click Next to begin the installation.
5 Click Yes to accept the license agreement.
6 Click Next to accept the default installation location.

or
Browse to and select the directory where you want to install the Import Utility, click OK, then 
click Next.

7 Click Finish after the program files have been installed.

3.4  Accessing Your GroupWise Mailbox
When your system administrator migrated your mailbox to GroupWise, a default password was set 
for you. You cannot start GroupWise without this password. If you have not yet received your 
GroupWise password, contact your system administrator. 

Be aware that your system administrator might have chosen not to migrate any items older than a 
certain date, sent items, deleted items, or journal entries from your Outlook mailbox.

1 Start the GroupWise Windows client.

You can see that the GroupWise Migration Utility run by your system administrator has created 
a new folder with subfolders for various types of items from your Outlook mailbox. By default, 
the new folder is called Exchange, but your system administrator might have chosen a different 
name.

You can leave migrated items in the Exchange folder or move them into folders in your 
GroupWise Cabinet as needed. The GroupWise Find feature helps you locate what you need in 
either case. Migrated items in the Exchange folder can be replied to and forwarded just like 
native GroupWise items, provided that your e-mail address is of the format 
userID@internet_domain_name. 

Your system administrator might have chosen to migrate items from your Outlook Inbox folder 
into your main GroupWise Mailbox folder and items from your Outlook Drafts folder into your 
GroupWise Work in Progress folder. If so, these migrated items are not found under the 
Exchange folder.

2 To replace the default GroupWise password provided by your system administrator with your 
own mailbox password, click Tools > Options > Security > Password.
Changing your password prevents other users from accessing your mailbox.
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By default, the GroupWise client starts in Online mode, which means that the client interacts 
actively with the Post Office Agent for your post office. In Online mode, if the Post Office 
Agent server goes down, you can no longer access your GroupWise mailbox. 
As an alternative, you can use Caching mode, where a copy of your Online mailbox is created 
on your local workstation. In Caching mode, if the Post Office Agent server goes down, you 
can still access your mailbox. Messages you want to send are saved until the client can contact 
the Post Office Agent again.

3 If you want to use Caching mode:
3a Click File > Mode > Caching.
3b Specify the directory where you want to create your Caching mailbox, then click OK.

The GroupWise client restarts whenever you switch between Online mode and Caching 
mode.
By default, the GroupWise client retains all messages in your Online mailbox indefinitely. 
Over time, your mailbox can grow very large. Your system administrator might choose to 
restrict the size of your mailbox. If you want to clean up your mailbox on a regular 
schedule, you can configure GroupWise to archive items after a specified amount of time 
is passed.

4 If you want to set up an archive:
4a Click Tools > Options > Environment > File Location.
4b In the Archive Directory field, specify the location where you want your archive, then 

click OK.
4c To control archiving, click Tools > Options > Environment > Cleanup.

If you want to access your GroupWise mailbox through a modem connection, perhaps 
from your laptop, you can create a Remote mailbox that provides a copy of all or only part 
of your Online mailbox and includes the information necessary to establish the connection 
to the network.

5 If you want to create a Remote mailbox:
5a Click Tools > Hit the Road.
5b Provide your GroupWise password, then click OK.

The Hit the Road Wizard then guides you through the rest of the setup process.

3.5  Importing Outlook PST Files into GroupWise
When you use the Import Utility, your PST file is imported into whichever version of your mailbox 
your currently accessing. If you run the utility with the GroupWise client in Online mode, the PST 
file is imported into your Online mailbox. If you run the utility when you are accessing your 
GroupWise archive, the PST file is imported into your archive.

1 If you want to import a PST file into a location other than your current one, select the location 
from the drop-down list above the Folder List (Online, Caching, Remote, or Archive).

2 Click File > Import PST.
3 In the New Root Folder field, provide the name of a new folder into which you want to import 

the contents of the PST file.
The new folder is created at the highest level of your GroupWise folder list in your mailbox or 
archive. 
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4 In the PST File field, browse to and select a PST file.
5 Click OK to start the import.

You can watch as the folder and its subfolders are created in your GroupWise mailbox or 
archive. You can leave the folder in its default location or move it to a location of your choice. 
Items from the PST file folder can be moved into other folders as needed.

6 Repeat Step 1 through Step 5 for each PST file you want to import.

If you want to import an Outlook Personal Address Book into GroupWise, you can place it in an 
Outlook PST file and then import it using the steps above.

3.6  Getting Acquainted with GroupWise
GroupWise is a cross-platform, corporate e-mail system that provides secure messaging, 
calendaring, scheduling, and instant messaging. GroupWise also includes task management, contact 
management, document management, and other productivity tools. GroupWise can be used on your 
desktop at work, in a Web browser anywhere you have an Internet connection, and even on wireless 
devices. 

Thanks to the Migration Utility that was run by your system administrator, the following tasks have 
already been done for you:

• Your GroupWise mailbox already contains all of the items that you had in your Outlook 
mailbox (unless your system administrator restricted the migration).

• Your personal Exchange distribution lists have been converted to GroupWise personal groups.
• All Exchange public folders have been converted into GroupWise shared folders. For each 

Exchange public folder where you had access, you should receive a notification that a 
corresponding GroupWise folder has been shared with you. 

• Your Exchange Contacts folder has been converted into a GroupWise address book and is 
displayed in the GroupWise Contacts folder.

And now the Import Utility has imported your personal items from Outlook into your GroupWise 
mailbox.

As you learn to use GroupWise, refer to the following sources:

• Click Help > Help Topics for assistance with common tasks.
• Click Help > User Guide to display the GroupWise 7 Windows Client User Guide in HTML 

format. The same guide is available in PDF format on the GroupWise 7 Documentation Web 
site (http://www.novell.com/documentation/gw7). You might want to print the “Getting 
Started” section as a quick reference for the GroupWise client.

• Click Help > Cool Solutions Web Community to join with other GroupWise users in learning 
the latest tips and tricks.

• Visit the GroupWise Support Forum (http://support.novell.com/forums/2gw.html) to get 
answers to your GroupWise questions from helpful GroupWise experts.

• Visit BrainStorm, Inc. (http://www.brainstorminc.com/gw7), a Novell Authorized Global End-
User Training Partner, to check for GroupWise client quick start cards, reference books, guides, 
training workbooks, and Web-based training.
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3.7  Adapting to Differences between GroupWise 
and Outlook
As you become familiar with GroupWise, you will find that you can perform most of your typical e-
mail tasks with ease. However, there are a few areas of functionality where GroupWise is 
substantially different from Exchange:

• GroupWise does not have a feature like the Outlook Journal feature. The Migration Utility run 
by your system administrator created a Journal folder in your mailbox where existing journal 
entries are stored as a reference, unless your system administrator chose not to migrate journal 
entries.

• Recurring items are stored in GroupWise as multiple, individual items, rather than as a single 
recurring item. This enables you to modify one or more of the recurring items individually, but 
does produce a large number of seemingly duplicate items. This is working as designed in 
GroupWise.

• GroupWise stores all contacts in a single address book that is linked to your Contacts folder, 
rather than storing contacts in multiple folders in your mailbox.

• GroupWise displays all appointments in the Calendar folder. If you had multiple Calendars in 
Outlook, all appointments are combined together in the GroupWise Calendar. However, you 
can display any GroupWise folder as a Calendar, so you can still view your separate Calendars 
in GroupWise.

• GroupWise allows you to store all types of items (messages, appointments, reminder notes, and 
so on) together in the same folder rather than having folders dedicated to specific item types.
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ANovell eDirectory Attributes 
Populated from Exchange

During migration from Microsoft Exchange to Novell® GroupWise®, the Migration Utility 
automatically populates the following eDirectoryTM attributes on User objects with information from 
the Exchange system when the GroupWise account is created:

eDirectory Attribute Description

assistant Assistant

assistantPhone Assistant’s phone number

company Company

country Country

homePhone Home phone number

L City

mobile Mobile phone number

otherPhoneNumber Business phone number

pager Pager phone number

Physical Delivery Office Name City

Postal Code ZIP code

S State

SA Street address
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BLinux Migration

If you are migrating from Exchange to GroupWise® on Linux, you must create the proper 
connection between the Exchange server and a Linux server where a GroupWise domain directory is 
located before you start the Migration Utility. Linux provides a configuration called a Samba share 
that allows a Linux file system to appear like a Windows disk drive from the point of view of your 
Exchange server.

• Section B.1, “Configuring the Samba Share for Your GroupWise Domain Location,” on 
page 61

• Section B.2, “Testing the Samba Share Access from Windows,” on page 62

B.1  Configuring the Samba Share for Your 
GroupWise Domain Location
Windows workstations use the Server Message Block (SMB) and NetBIOS protocols for sharing 
drives. By configuring your Linux server to support these protocols, your Windows workstation can 
access your Linux server as if it is a shared drive.

1 On the Linux server, add the user that you plan to log in as when you run the Migration Utility.

You set up this user on the Windows side in Section 2.1.2, “Designating a Service Account 
Administrator on Exchange 5.5,” on page 28 or Section 2.1.3, “Ensuring Administrative Rights 
on Exchange 2000/2003,” on page 29. Now you are setting up the user on the Linux side. Use 
the same username on Linux as you used on Windows. The steps below provide an example.
1a In a terminal window, log in as root.
1b Enter the following command to create the user:

useradd -mg root username

1c Enter the following command to assign a password to the user:
passwd username

Use the same password on Linux as you used on Windows.
1d Enter the password, then enter it again for verification.

2 Add the user and password to the list of users that can authenticate to the Samba server, for 
example:
2a Enter the following command:

smbpasswd -a username

2b Enter the password, then enter it again for verification.
3 Start the Samba server, for example:

3a Change to the /etc/rc.d directory.
3b Start the NetBIOS daemon:

./nmb start

3c Start the Samba daemon:
./smb start
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If a message notifies you that the daemon is already running, stop and then start it to pick 
up the new username and password information.

B.2  Testing the Samba Share Access from 
Windows
After you have configured the Samba share on the Linux server, you should test it on the Windows 
workstation where you plan to run the Migration Utility.

1 Map a drive to the Linux server, for example:
1a Right-click My Network Places, then click Map Network Drive.

IMPORTANT: Do not use Novell Map Network Drive. The Samba share is set up to work 
with Windows, not with the Novell ClientTM.

1b Select a drive letter.
1c In the Folder field, specify the IP address of the Linux server and the Linux username you 

created in Step 1b in Section B.1, “Configuring the Samba Share for Your GroupWise 
Domain Location,” on page 61, for example:
\\172.16.5.18\gwmigrate

1d Click Finish.
1e When prompted, provide the username and password established in Step 1b and Step 1c in 

Section B.1, “Configuring the Samba Share for Your GroupWise Domain Location,” on 
page 61.
This shows that the Samba share is working correctly from the Windows operating system 
level.

2 Start ConsoleOne® and authenticate to the eDirectory tree where your GroupWise system is 
located.

3 Connect to the GroupWise domain on the Linux server.
3a Click Tools > GroupWise System Operations > Select Domain. 
3b Browse to and select the domain database (wpdomain.db) on the Linux server, then 

click Open.
3c Click OK to connect to the domain.

If you can connect to the domain, then the Migration Utility can successfully migrate users from 
your Exchange system to GroupWise on Linux. If you cannot connect to the domain, the migration 
from Exchange to GroupWise on Linux cannot succeed. Some Linux Samba servers require more 
stringent authentication than others. You can find assistance with setting up the connection between 
Windows and your Linux server from the following resources:

• The Official Samba-3 HOWTO and Reference Guide (http://www.comp.hkbu.edu.hk/docs/s/
samba30/htmldocs/howto)

• GroupWise Support Forum (http://support.novell.com/forums/2gw.html)

The connection must be set up correctly before you start the migration process.
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CGroupWise 7 Migration Utility 
Error Messages

The Novell® GroupWise® 7 Migration Utility for Microsoft Exchange might generate the messages 
in the “Error Message List” on page 63. Error messages display while the Migration Utility runs and 
are written to the migrate.log file located in the Migration Utility installation directory.

C.1  Error Message List
• “Error EID 0200 -- Could not open Exchange private store” on page 63
• “Error EID: 0202 -- Could not open Exchange mailbox table” on page 64
• “Error EID: 0205 -- Could not log onto Exchange server through MAPI” on page 64
• “Error EID: 0207 -- Generated exception accessing Exchange mailbox store.” on page 64
• “Error EID: 0208 -- Could not log onto mailbox” on page 64
• “Error EID: 0232 -- User not created” on page 65
• “Error EID: 0247 -- Could not open GroupWise MAPI store provider for specified user” on 

page 65
• “Error EID: 0258 -- Could not attach to eDirectory context” on page 66

Error EID 0200 -- Could not open Exchange private store

Source: GroupWise Migration Utility for Microsoft Exchange

Explanation: The Migration Utility could not access the mailbox store on the Exchange 
server. This error might be accompanied by the additional error, 
“Properties for this information service must be 
defined prior to use.”

Possible Cause: The Windows desktop account being used by the user running the Migration 
Utility does not have Admin rights.

Action: Before running the Migration Utility, follow the instructions in Section 2.1.2, 
“Designating a Service Account Administrator on Exchange 5.5,” on page 28 
or Section 2.1.3, “Ensuring Administrative Rights on Exchange 2000/2003,” 
on page 29, depending on your version of Exchange. When you log into the 
Windows desktop, make sure that you use the account you set up specifically 
for use with the Migration Utility.

Possible Cause: Outlook has been installed on the Windows machine where you want to run 
the Migration Utility but you have not yet run Outlook. Outlook must be run at 
least once in order for its MAPI providers to be available for use by the 
Migration Utility.

Action: Run Outlook before running the Migration Utility.

When starting, if Outlook prompts you to fix another application that is 
installed on the workstation, click Yes. If it does not prompt you, click Help > 
Detect and Repair, then click Start after Outlook is running.
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Error EID: 0202 -- Could not open Exchange mailbox table

Source: GroupWise Migration Utility for Microsoft Exchange.

Explanation: The Migration Utility could not read the list of mailboxes in your Exchange 
system.

Possible Cause: The user that is running the Migration Utility does not have administrator 
rights to the Exchange server or the Domain object in the Exchange system.

Action: Configure the user that runs the Migration Utility to have administrator rights, 
as described in Section 2.1.2, “Designating a Service Account Administrator 
on Exchange 5.5,” on page 28 or Section 2.1.3, “Ensuring Administrative 
Rights on Exchange 2000/2003,” on page 29, depending on your version of 
Exchange.

Possible Cause: The workstation where you are running the Migration Utility does not have a 
username and password that matches a username and password with 
administrator rights on the Exchange server.

Action: Set up a username and password on the workstation where you are running the 
Migration utility that matches a username and password on the Exchange 
server.

Error EID: 0205 -- Could not log onto Exchange server through MAPI

Source: GroupWise Migration Utility for Microsoft Exchange.

Explanation: The Migration Utility cannot access the Exchange server.

Possible Cause: The Exchange server is down.

Action: Make sure that the Exchange server is running.

Possible Cause: The workstation where you are running the Migration Utility has Outlook 
2002 but no Service Packs have been applied to it. 

Action: Apply Outlook 2002 Service Pack 1 or later.

Error EID: 0207 -- Generated exception accessing Exchange mailbox store.

Source: GroupWise Migration Utility for Microsoft Exchange.

Explanation: The Migration Utility cannot access the mailbox store on the Exchange server.

Possible Cause: The workstation where you are running the Migration Utility has Outlook 
2002 but no Service Packs have been applied to it. 

Action: Apply Outlook 2002 Service Pack 1 or later.

Error EID: 0208 -- Could not log onto mailbox

Source: GroupWise Migration Utility for Microsoft Exchange.

Explanation: The Migration Utility cannot access a mailbox that was selected for migration.

Possible Cause: The mailbox was deleted from the Exchange system between the time it was 
selected for migration and the time when the migration session was run.

Action: None. The mailbox is no longer available for migration.
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Error EID: 0232 -- User not created

Source: GroupWise Migration Utility for Microsoft Exchange.

Explanation: The Migration Utility could not create a GroupWise account for the Exchange 
user.

Possible Cause: The username already exists in eDirectoryTM.

Action: Rename the Exchange mailbox so that the associated username is unique in 
eDirectory.

Action: Rename the existing GroupWise user so that the Exchange username is unique 
in eDirectory. See “Renaming Users and Their GroupWise Accounts” in 
“Users” in the GroupWise 7 Administration Guide.

Possible Cause: The eDirectory account file does not contain an eDirectory context for the 
username.

Action: Provide complete information in the eDirectory account file, as described in 
Section 1.2.4, “Preparing eDirectory for Your GroupWise System,” on 
page 14.

Possible Cause: The Post Office Agent (POA) for the post office where the user is being 
migrated is not running.

Action: Start the POA. See the appropriate section in “Installing GroupWise Agents” 
in the GroupWise 7 Installation Guide:

• “Starting the NetWare GroupWise Agents”
• “Starting the Linux GroupWise Agents as Daemons”
• “Starting the Windows GroupWise Agents”

Error EID: 0247 -- Could not open GroupWise MAPI store provider for specified user

Source: GroupWise Migration Utility for Microsoft Exchange.

Explanation: The Migration Utility could not access the GroupWise mailbox that it 
previously created for the user.

Possible Cause: The Post Office Agent (POA) for the post office where the user is being 
migrated is not running.

Action: Start the POA. See the appropriate section in “Installing GroupWise Agents” 
in the GroupWise 7 Installation Guide:

• “Starting the NetWare GroupWise Agents”
• “Starting the Linux GroupWise Agents as Daemons”
• “Starting the Windows GroupWise Agents”

Possible Cause: The mailbox was created during a previous migration session and has now 
been removed from the GroupWise system.

Action: Select the mailbox again in a subsequent migration session.

Possible Cause: The eDirectory object for the user exists but the GroupWise account could not 
be created.

Action: Select the mailbox again in a subsequent migration session.
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Error EID: 0258 -- Could not attach to eDirectory context

Source: GroupWise Migration Utility for Microsoft Exchange.

Explanation: The Migration Utility could not locate the eDirectory context where it has been 
instructed to create User objects for Exchange users.

Possible Cause: The context does not exist in eDirectory.

Action: Create the eDirectory context using ConsoleOne®.

Action: Specify an existing context in the Migration Utility.
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DDocumentation Updates

This section lists updates to the GroupWise 7 Migration Utility for Microsoft Exchange Installation 
and Administration Guide that have been made since the initial release of the Migration Utility. The 
information helps you to keep current on documentation updates and, in some cases, software 
updates (such as a Support Pack release).

The information is grouped according to the date when the GroupWise 7 Migration Utility for 
Microsoft Exchange Installation and Administration Guide was republished. Within each dated 
section, the updates are listed by the names of the main table of contents sections.

The GroupWise 7 Migration Utility for Microsoft Exchange Installation and Administration Guide 
has been updated on the following dates:

• Section D.1, “August 23, 2006,” on page 67
• Section D.2, “March 20, 2006,” on page 68

D.1  August 23, 2006

Location Change

Section 1.2, “Planning Your 
Migration from Exchange to 
GroupWise,” on page 10

Significantly expanded the planning section.

Section 1.3, “Installing the 
Migration Utility,” on page 20

Added planning worksheet cross-references to the steps in the 
procedure.

Section 1.4, “Exchange 
Migration Planning 
Worksheet,” on page 21

Added more detail to the worksheet.

Section 2.1, “Preparing Your 
Exchange System for the 
Migration,” on page 27

Added more preparation tasks.

Section 2.2, “Preparing Your 
GroupWise System for the 
Migration,” on page 32

Added more preparation tasks.

Section 2.3, “Routing 
Messages between the Two 
Systems during the 
Migration,” on page 37

Dealt with the issue of handling incoming Internet mail during the 
migration process.

Section 2.4, “Starting the 
Migration Utility,” on page 39

Added planning worksheet cross-references to the steps in the 
procedure.

Section 2.5, “Using the 
Migration Utility,” on page 40

Added planning worksheet cross-references to the steps in the 
procedures.

Section 2.5.4, “Migrating 
Exchange Public Folders,” 
on page 47

Clarified that you can migration Exchange public folders to multiple 
post offices if the public folders are located on multiple Exchange 
servers.
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D.2  March 20, 2006

Section 2.6, “Performing 
Post-Migration Tasks,” on 
page 48

Added post-migration task for GroupWise and Exchange.

Location Change

Section 1.1, “Meeting 
Migration Utility System 
Requirements,” on page 9

Indicated that the Migration Utility should be installed on a Windows 
workstation, not on an Exchange server; revised the Windows and 
Outlook version requirements

Section 1.3, “Installing the 
Migration Utility,” on page 20

Emphasized that the Migration Utility should be installed on a Windows 
workstation, not on an Exchange server.

“Distributing and Installing 
the GroupWise Import Utility 
for Microsoft Outlook” on 
page 49

Included a link to instructions for installing the GroupWise® Import 
Utility for Microsoft Outlook along with the GroupWise Windows client 
by using the GroupWise Auto-Update and SetupIP features.

“Error EID 0200 -- Could not 
open Exchange private 
store” on page 63

Clarified possible causes and actions.

“Error EID: 0232 -- User not 
created” on page 65

Added a new possible cause and action.

Location Change
7 Migration Utility for Microsoft Exchange Installation and Migration Guide
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